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PROGRAM NAME GOES HERE

“Episode Title Goes Here”

Prod. #27

CAST

ANNOUNCER



The announcer.

CHARACTER NAME #1

Brief character description.

CHARACTER NAME
#2

Nervous novice writer. (Age 34)

NOTE: 

The above list is for a cast of XX. A smaller cast of X can be used if the following roles are combined for one actor each:

CHARACTER #5/CHARACTER #6

CHARACTER #7/CHARACTER #8/CHARACTER #9
Four sound effects artists are also required.

Two walla walla artists are also required.

Visit Tony Palermo’s Radio Drama Resources website: http:/www.RuyaSonic.com


NOTE: To make better use of this template, go to my website listed above and read my “Radio Drama Resources” articles and lessons on Writing, Engineering, Directing, Scoring, and Sound Effects. They’ll fill you in on what the various conventions of this radio script format mean--things such as why the music cues have a box with [A-4]. Plus other bits that I don’t want to cram into this template. My very detailed  lesson in writing clear radio drama cues is found at: http://www.RuyaSonic.com/wrt_cues.htm 
NOTE: At the very end of this document you will find instructions for how to make good use of the template.

The radio drama script template is copyright 1996-2018 by Anthony E. Palermo. 

Scene 1 - INT. YOXPOKPETL CONCERT HALL - MIDNIGHT
(Announcer, VILLAIN, BYSTANDER)
1.
MUSIC: [A-1]
INTRO THEME--UP. Establish. FADE UNDER.

2*
ANNOUNCER:
Yes, friends! It’s time for sample dialogue, brought to you by RuyaSonic, the most informative... (GASPS) Wait! Look! Up in the sky! It’s a bird! 
3.
BYSTANDER:
(AMAZED) It’s a... plane? 
4.
LIVE SFX:
SLIDEWHISTLE--DESCENDING TONE, INTO...

5.
SFX-TRACK: [B-1]
GRAND PIANO DROPS ON ANNOUNCER—REVERBERATES UNDER.

6.
VILLAIN:
(CLEARS THROAT) Ahem. It’s... over!
--THE END--
Writer/Director’s notes for “Episode Title Goes Here”
Radio Skills School

Microphone Technique:

1) Sensitive and dead areas. Don’t touch! 

2) Proximity effect. (Boomy if too close.)

3) Proper distance for radio acting.

4) Dynamics and distance. (Back off to yell.)

5) Off-mic use for distant sounds. Asides.

6) Popping “P”s and S-S-S-Sibilance.

7) Mic safety. (hitting, blowing, dropping)

8) Assume every mic is always ON.

9) Quiet script page turning.

Radio Acting:

1) Quiet in the studio.

2) Don’t cough, laugh, or talk during production.

3) Watch the director. Wait for your cue. (Q)

4) Speed equals excitement. Don’t bore the audience.

5) Jump in if there’s dead air.

6) Wait for director’s signal at end of show.

Radio Direction “Sign Language”

1) “Wait.”  Open hand.

2) “5-4-3---” Finger count down.

3) “You’re on.” Pointing finger.

4) “Quicken the pace.” Finger draws circles.

5) “Stretch it out.” Pulling taffy.

6) “Louder.” Pull ear.

7) “Quieter.” Finger to lip (Shhhh-style)

8) “Cut.” Finger slits throat.

9) “Come in” or “Back off” microphone.
CASTING EVALUATION:



Date: __________

“Episode Title Goes Here”  (# of actors required - # of SFX artists)
________________
ANNOUNCER



The announcer.

​​​

________________
CHARACTER NAME


Nervous writer.(Age 34)

________________
CHARACTER NAME


Brief character desc.

________________     -also- MINOR PART

A nasty henchman.

============================================================

Audition ratings: A through F

	Actor Name
	Rating
	Bold?
	 Emotion?
	Accents
	Role?
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“Episode Title Goes Here”
CASTING MONOLOGUES:
All actors are asked to read some lines, called “sides,” aloud, to audition. The director will cast the roles in our production based upon these readings. Please take a moment to read the lines below several times, both silently and aloud. These monologues can also provide some “back story,” giving an idea of who the characters are and what kind of story we are producing. Since radio drama actors often play several parts, we encourage the use of different voices or accents when auditioning for the different roles. 

ANNOUNCER:
I’m the announcer. I quickly describe the setting for each scene and report on all spine-tingling suspense for the radio listener. These lines often include underlined phrases to instruct the actor to stress or emphasize or just read the underlined words slower.

CHARACTER #1:
Hello, I’m Character #1, this text describes me and contains certain typical phrases I use. It is to educate the cast and crew about the characters before we begin work. Also, by giving a fairly long speech--in character--a director can evaluate my voice for its tone and my ability to read a script--live--well.
CHARACTER #2:
I’m Character #2, this text describes me and contains certain typical phrases I use. By having the actors say all these lines we can cast the better speakers in the leading roles.

SOUND EFFECT ROLES: “Episode Title Goes Here”
SOUND EFFECT ARTIST #1:

SOUND EFFECT NAME GOES HERE 

SOUND EFFECT NAME GOES HERE

SOUND EFFECT NAME GOES HERE

SOUND EFFECT NAME GOES HERE

SOUND EFFECT ARTIST #2:

TRAIN SLOWING

CAR CRASH

SOUND EFFECT ARTIST #3:
SOUND EFFECT NAME GOES HERE

SOUND EFFECT NAME GOES HERE

CAST MEMBERS:
AUDIENCE APPLAUSE

AUDIENCE WALLA WALLA

WOMAN SCREAMS

SOUND EFFECT HOW TO: “Episode Title Goes Here”
TRAIN SLOWING:


Drummer’s brush on washboard

TRAIN WHISTLE:


Wooden train whistle.

SWORD UNSHEATHED:


Pancake flipper scraped against metal mixing spoon.

Engineer’s Notes: “Episode Title Goes Here”
EQUIPMENT REQUIREMENTS:


A typical notice here would be: This show requires the use of a filter mic for telephone effects Also, run the Sound Effects microphone through a reverb and be prepared to vary the amount of reverb as the director indicates by hand signals.

MUSIC CUES:

A complete engineer’s script will be provided with colored highlighting to show how long music cues run (through scenes and dialogue) and which characters are using reverb or filters, and when.

1) The Intro Theme: (0:14) [A-1]


Composer Name “Musical Title Goes Here” 


NOTE: It is used in intro and outro only.

TEMPLATE NOTES:
This radio script template allows you to write in the final format of the script. This classic “block” style format uses a 12-point Courier font of 1940s typewriters, although I’ve bolded it to make it photocopy better. Each page of script in this format runs about 55 seconds of air time--it depends on the pace of the direction. Other conventions of the format are explained in the script itself.  


Let me stress a few conventions I use in my radio drama scripts that differ from conventional script styles for stage and screen.

DIALOGUE DELIVERY INSTRUCTIONS

For dialogue, I specifically recommend that you make full use of underlines, ellipses [But...] and parentheticals [(DRUNK) (WHISPERS) (PAUSE) etc.] to indicate how the actors should deliver the lines. There's never much rehearsal time in radio drama, so these instructions quickly convey just what the writer intended. We are working live, remember.
Some directors wish to let the actors deliver lines the way they feel it, and hope they get it right. However, as the writer, I wrote it one way and want to make sure it reads easily and is delivered as I intended it. Actors can still bring nuance and interpretation to their parts, but I don't want them mis-understanding what the lines are about--especially live! Clarity is paramount in audio theatre. Do it!
CHARACTERS IN A SCENE

After the “slug line” identifying a new scene, I include the character names used in the scene, to alert any actors who are sitting down to get up and come to the mic. It also allows for quick casting calls in rehearsal. (“I need Debs, Fido, and Cap’n Twitshire for this scene.”)
Here's an example of the slug line with featured characters for a scene:

SCENE FOUR - EXT. PIRATE SCHOONER - DAY
    (Neville, Teresa, Catalina, Baptiste, Lookout)

CUE NUMBERING

Also, when I'm writing my script, I just put an “X” instead of a number for the cue. Then after I've finished with all my drafts, I replace the Xs with numbers.

Example:

X.  NEVILLE:

(CALLS OUT) Ahoy, you skulking dogs!

X.  BAPTISTE:

(DISTANT) Aye, Cap'n!  


MARKING UP THE FINAL DRAFT

After I've printed out the production draft, I take a Sharpie pen and hand-write the letter "Q" alongside any cues where the actor, music, or SFX crew should wait for the director to cue them. Everybody will work off of the marked up script. This is usually in specific places:

1) On the first dialogue cue following a music cue--so the director can wait until the music cue is established or fades. This is often at the beginning of a new scene.

2) On a dialogue cue after an important sound effect--so that effect can "clear" and not get stepped on by the actors.

3) On a music or SFX cue that must precisely follow the director's timing. Say, where a gunshot SFX cue is followed by a suspenseful pause and then the sound of a body dropping to the floor.

These "Qs" easily tell everyone to wait for the director. They make rehearsals and performances run much smoother. Since it's handwritten and bold, these “Qs” really stand out amidst the typed text.

What I do when typing a script is substitute an asterisk for the period after a cue number, so I can remember where these hand-written "Q" marks should go. So, you'll see:
2*
NARRATOR:

Some dialogue goes here.

When marking up scripts, I also use a Sharpie pen to circle the walla walla cues (background crowd sounds). This way the cast can all see when walla is required. 

PREPARING RADIO SCRIPTS FOR PRODUCTION

If you're using my script template, also take a look at my website's pages about preparing for production. The advice on using hi-lighters for the engineers and SFX department are real time savers.

http://www.RuyaSonic.com/pre-prod.htm
How to customize this template FOR YOURSELF
1) Make a copy of the template under a new name and store it as a template in your MS Word template folder. They end in .dot, instead of .doc for the file name’s extension.

2) Now, print out the template, so you’ll have a paper reference of the “how to” aspects.

3) Go through the template and delete all my notes, like this one. You may also choose to delete most of the dummy dialogue and other radio cues. 

4) Go to the first page and use the MS Word “search and replace” feature to put your own info in place of my generic entries about author name and production company.

5) Go to the “View” menu, click on “Headers and Footers” and replace the footers entries for the production company address and e-mail address with your own info.


6) Make sure the floating toolbar is visible. Go to the "View" menu, click on "Toolbars" and check the "Radio Script" toolbar. You may wish to uncheck the standard Word "Formatting" toolbar since there are several duplications of commands.

7) Now, save the template again to whatever name you want. This will be your regular starting template for writing radio scripts. Close the document.

8) To write a script, go to the “File” menu, click on “New”  and choose to base the document on your template. Then use MS Word’s “search and replace” feature to put in your program name and episode title throughout the document and also in the headers. 

Now, just remember--”write between the ears” and you’ll be a radio dramatist in no time! 

PRINTING BY SECTION:
This script uses many section breaks to allow for quick printing. The pages used for actors copies are 
Sections 1-3. You can print just these sections by going to the MS Word “Print” page, and designating pages: S1-S3.
To print just a few pages from within a section, specify a page range first, like p18-24 S3  (Section is always last).


Here’s a breakdown of the sections:
Section 1 - Title (fly) page
Section 2 - Cast listing page
Section 3 - Script pages (dialogue, music, SFX)
Section 4 - Casting Evaluation page
Section 5 - Casting Monologues
Section 6 - Director’s Notes
Section 7 - Sound Effects Chief’s notes
Section 8 - Engineer’s Notes
Section 9 - Writer’s Notes.

GOOD LUCK!
Tony Palermo TPalermo@RuyaSonic.com
www.RuyaSonic.com
Last revised: October 2018 
This template © 1996-2018  Anthony E. Palermo.  All rights Reserved.
